Enter Data and Create Data File

In this assignment, we shall learn data entry in SPSS and how to use the **Graphs** utility to create a single subject design chart.

We shall be working with an A-B-A evaluation of a technique for helping an eight-year-old child stay on task during a twenty-minute physical therapy session. The dependent measure is number of minutes on task.

The following table depicts the results over the three-week evaluation period.

<table>
<thead>
<tr>
<th>Day</th>
<th>Baseline</th>
<th>Intervention</th>
<th>Withdrawal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sunday</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monday</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tuesday</td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wednesday</td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thursday</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Friday</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Saturday</td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sunday</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monday</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tuesday</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wednesday</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thursday</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Friday</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Saturday</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sunday</td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monday</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tuesday</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wednesday</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thursday</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Friday</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Saturday</td>
<td>10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The chart is laid out in the same way that the SPSS data spreadsheet needs to be laid out. Each phase must be entered in its own column so that the lines in the chart will not be connected across phases.
So, here's what we do.

Start SPSS for windows and go to the SPSS **Data Editor** window.

The first thing that we are going to do is to define the variables.

Place your mouse pointer over the **Variable View** tab at the bottom of the window and click on it.
We shall name the first variable "day". Click in the Name column and the first row and type in the variable name. After typing in the name, click in the Type column and the first row.

This takes us to the

Most variables that we shall be using will have numeric values. This is the default classification (Numeric). The default format for numeric variables is F8.2 (width of eight digits with two digits to the right of the decimal point).

Variables that do not have numeric values are called "string" variables (please ignore the other types). Our first variable, "day", is a string variable (values are "Sunday", "Monday", etc.). So, click in the String radio button.
A dot should appear in the String radio button. The variable "day" is now classified as a string variable.

By default, string variables are eight characters wide. Accept the classification of the variable "day" as a string variable and the default character width value by clicking on the OK button.

This takes us back to the Data Editor window.

We are now ready to define the Baseline phase. Click in the Name cell in the second row.

Type the variable name "base" inside the second row Name cell.

Since Baseline measures are numeric, let the default classification (Numeric) stand. However, since values for the dependent measure (minutes) are whole numbers, you will change the format of the variable.
If you click in the Decimals cell, an up arrow and a down arrow appear in the right corner of the cell. Since you have not measured fractional minutes, click on the down arrow until the value for Decimals equals zero.

Do the same for the next two phase variables. Call the Intervention phase variable "intervtn" and the Withdrawal phase variable "wthdrl".
After you have defined the variables, click on the Data View tab, so that you may enter the data. Begin by clicking in the first row of the day variable column. Enter the values Sunday through Saturday for the three-week period.

When you are finished, the day column should have entries for rows 1 through 21. Note that dots have appeared in the columns for the other variables. This signifies missing values for those cells.
Now click in row one for the **base** variable and enter the Baseline values for each day. When you are finished, you should have values in rows one through seven in the **base** column.

Click in row eight for the **intrvntn** variable and enter the Intervention phase values for each day. When you are finished, you should have values in rows eight through fourteen in the **intrvntn** column.

Finally, click in row fifteen for the **wthdrwln** variable and enter the Withdrawal phase values for each day. When you are finished, you should have values in rows fifteen through twenty-one in the **wthdrwln** column.

When you are finished, the **Data Editor** window should look like the following figure.

![Data Editor Window](image)

Having done all this, you don't want to do it again, so save your file.
You begin by clicking on the **File** menu header. From this menu, you select the **Save As**... option.

This will take you to the **Save Data As** dialog box (following figure).

I have selected the **3½ Floppy** drive from the **Save in**: dropdown box for my file destination. You may choose some other if you wish.
Type in **assign06** in the **File name:** text box. The default file type (**SPSS (*.sav)**) is selected in the **Save as type:** drop down box.

After you have typed the file name, click on the **Save** button. This will return you to the **Data Editor** window. Note that the data file name now appears at the top of the window.

The next step is to define the single subject chart.
Click on the **Graphs** menu header.
From the **Graphs** menu, select the **Line**... option.

This takes you to the **Line Charts** dialog box. Select the **Multiple** option and click on the radio button for **Values of individual cases**.

Once you have done these, click on the **Define** button.
This takes you to the **Define Multiple Line: Values of Individual Cases** dialog box.

The X-axis of the chart will be the days of the week. SPSS refers to the X-axis as the category axis, so the **Category Labels** will come from the **day** variable.

First you click on the **Variable** radio button in the **Category Labels** section of the box. Then you highlight **day** by clicking on it.
You move the **day** variable name over to the **Category Labels** section by clicking on the right arrow button in the **Category Labels** section.

Now it is time to define the Baseline, Intervention, and Withdrawal lines. You begin by clicking on the **base** variable name to highlight it.
There is a right arrow button beside the **Lines Represent** box. Click on it to move **base** into the **Lines Represent** box.

Now highlight **intrvntn** and move it in the same way into the **Lines Represent** box. Then do the same with **wthdrwl**.
The chart is now fully defined.

Press the **OK** button to have SPSS prepare your chart.
Output: Results

The following figure depicts the output as displayed by the SPSS Viewer.

I want you to edit this chart a bit. Please double click in the middle of the graph to open the Chart Editor (see next figure).
You are now in the Chart Editor.
I want you to get rid of the legend to the right of the chart.
Please click on the **Chart** menu header.
From the **Chart** menu please select the **Legend** \ldots option.

This will take you to the **Legend** dialog box.

The default is to **Display legend**. Click in the check box to remove the check mark. Then click on the **OK** button to return to the **Chart Editor**.

Next I want you to set up the axes of the chart.
Again you click on the Chart menu header, but now select the **Axis** . . . option.

This takes you to the **Axis Selection** dialog box.

SPSS calls the Y-axis (the vertical axis) **Scale** and the X-axis (the horizontal axis) **Category**.

Begin with the **Scale** axis (make sure the **Scale** radio button has a dot in it and press the OK button).

This takes you to the **Scale Axis** dialog. There are a number of characteristics of this chart I want you to change.

The first is the **Axis Title**. Rather than **Value**, I want you to call it **Minutes on Task**. Please type this into the **Axis Title** text box.
Next I want you to change the **Title Justification** from **Left/Bottom** to **Center**. Make this change in the **Title Justification** drop down box.

Finally, I want you to change the **Range** for the **Minimum** and **Maximum** on the X-axis. In the **Displayed:** text boxes, type in **0** for the **Minimum** and **20** for the **Maximum**.

The **Scale Axis** dialog box should resemble the following figure:

![Scale Axis Dialog Box](image)

Now, click the **OK** button to return to the Chart Editor.

Click on the **Chart** menu header, and select the **Axis...** option again.

In the **Axis Selection** dialog box, choose the **Category** option and press **OK**.

![Axis Selection Dialog Box](image)

![Category Axis Dialog Box](image)

This takes you to the **Category Axis** dialog box.

The **Axis Title:** is **DAY**. I want you to delete this and leave the **Axis Title:** text box blank.
Now click on the **Labels**... button. This will take you to the **Category Axis: Labels** dialog box.

I want you to change from the default **Display** to **All Labels** by clicking inside the **All Labels** radio button.

Use the **Orientation**: drop down box to change label orientation from **Automatic** to **Vertical**.

After you have done this, please click on the **Continue** button.

This will take you to the **Category Axis** dialog box.

From here, click on **OK** to get back to the **Chart Editor**.
Now that you are back to the chart editor, click once on the Baseline to select it for editing. This should cause little markers to appear on the line.
Now, click on the **Format** menu header and select the **Color**... option.

This will take you to the **Colors** dialog box. Select the black square from the palette. Then click on the **Apply** button.

This will take you back to the **Chart Editor**.

Now click on the **intrvntn** line to highlight it.

Again, click on the **Format** menu header and select the **Color**... option.

You will be in a new **Colors** dialog box. Select black from the palette, **Apply** it, and **Close** the box.

Repeat the procedure for the **wthdrwl** variable.
This takes you back to the Chart Editor.

Click on the **Line Style** button to get to the **Line Styles** dialog box.

In the **Line Styles** dialog box increase the weight as shown.

In the **Weight** column, click on the line weight shown, the click on the **Apply** button and then on the **Close** button.

Repeat this process for the **intrvtn** and **wthdrwI** lines.
Once you are back in the **Chart Editor**, open the **File** menu and pick **Close**.

This closes **Chart Editor** and takes you back to the **SPSS Viewer**.

I want you to put your name on the output.

You may do this by double-clicking on the word **Graph** in the right output window.
This will open up the text area for edition.

Type your name in the text area.
Now save this output to disk.

Make your file name the first six letters of your last name followed by the digits 06. For example,
Now close the output (SPSS Viewer window) and the Data Editor.

Send the output file as an e-mail attachment to Barbara Hughes at BarbaraMHughes@aol.com

Remember that the output file name should be the first six letters of your last name followed by the digits 06. For example, if I were sending my file, it would be named stockso6.spo

Please use this file naming convention. Otherwise, files overwrite each other and are lost.